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PowerPoint is a program with which you can create slide shows, overheads, and graphics-driven presentations. 

 

                                                                                                                Choosing a Template                                                                                                                        

 

Select a template to begin creating your presentation. A

 

 

 

template

 

 

 

is the structure of  your presentation. There are two 
ways of  choosing a template; the first way is to select the Template option from the startup dialog box. You will see 
this dialog box when you first open PowerPoint

The second way of  selecting a template: Under the File menu, select New, then click on the Designs button. (Go to 

 

File/New/Designs.

 

)

You will see this dialog box.

When you click once on a template icon, a thumbnail sketch will appear in the preview box. Select a template that 
suits your presentation style, and click OK.

You cannot combine multiple template layouts. However, you can apply different color schemes to or omit back-
ground objects in individually selected slides or to the entire presentation. Go to the

 

 Format menu/Slide Color 
Scheme

 

 or 

 

Background

 

 to change the template color or to delete objects. By selecting

 

 Apply to All, 

 

the changes 
you make will be applied to the entire presentation; selecting

 

 Apply 

 

will only affect the slide you are currently work-
ing on.
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Choosing a Presentation Format                                                                    

 

After selecting a template style, you’ll see this Auto Layout dialog box.

PowerPoint offers you various presentation formats to use as  guides in each slide you create. You will be prompted 
with this

 

 AutoLayout 

 

dialog box every time you make a new slide.

If  you want to select a different format from your first choice, go to

 

 Format/Slide Layout

 

 and choose a different 
layout.

 

Important Considerations

 

Before you start on your presentation, consider the following questions.

1. In what format will your presentation be? On-line electronic slide show? 35mm slides? Transparencies?
Go to

 

 File/Page Setup

 

 and click on the arrow button next to “on-screen show” for various formats. Remem-
ber, changing the page set-up after you create your presentation may affect the layout and format of  the presenta-
tion.

2. Will your presentation be portrait or landscape-oriented?
Go to

 

 File/Page Setup.

 

 Under Orientation, choose the appropriate position for your presentation. Remember, 
changing the page set-up after you create your presentation may affect the layout and format of  the presentation. 

3. Will your presentation be delivered in color or black and white?
If  you are making overheads, it would be wise to use color judiciously. If  you do not have a color printer, your 
presentation can be created in color and printed out in black and white. Go to

 

 File/Print 

 

and mark the box next 
to Black and White. If  you wish to view your color presentation in black and white, click on the Black & White 
View button in the top toolbar. 

Title Slide

Text & Clip Art

Chart

Table

Blank

Text & Chart

Click on this Arrow for More Formats



  
Formats Other Than Presentation Format

 

PowerPoint not only creates presentations, but it offers various formats to facilitate your work. At the bottom left of  
your PowerPoint window, you’ll see the View toolbar.

 

Normal Outline Slide Slide Sorter ViewSlide Show

 

Slide View takes you to the slide currently in production.

Outline generates an outline from your text slides. Conversely, you can start making your presentation using an out-
line; PowerPoint will create a presentation based on that outline. 

Slide Sorter displays all the slides in your presentation. You can switch the slide sequence, make copies, or delete 
slides while in this mode. 

Notes add text under each slide for two purposes: a presentation aid containing points to elaborate during your pre-
sentation, and a handout to the audience who may benefit from further elaboration or explanation pertaining to the 
content of  each slide. Notes will not appear as part of  your presentation.

Show will present your slide as it will appear during your presentation.

 

N

 

ormal view   simultaneously displays the slide, outline, and notes views in their own adjustable panes.

You can click on any of  these five icons, or go to the View menu and select a mode. 

 

Various Mouse Functions

 

Use the mouse to select text box or objects, move, and re-scale them. 

 

To Re-scale a Text Box

 

Click once inside the box to activate the defining border, or

 

 selection rectangle.

 

 You will see small squares on each 
corner of  the box as well as in the middle of  the top and bottom borders. These are

 

 sizing handles.

 

 If  you move the 
mouse pointer over a sizing handle, it will turn into a double-headed arrow. At this point, keep your mouse button 
down and drag the arrow to re-scale the text box. 

 

To Move a Text Box

 

Click once inside the box to activate the defining border. Point at the border, not at the sizing handles. When you get 
a closed hand, move the text box.



  
                                                                                                                  Text                                                                                                                              

 

Text boxes in PowerPoint presentation slides will prompt you to click the box to start typing. 

 

To Change the Font

 

Go to 

 

Format/Font.

 

 You can change the font style, size, and color in this menu. Make sure the text box is defined 
by clicking inside the text box and click once on the text border, to change the font of

 

 all

 

 the text in that box. To 
change part of  the text, highlight it (click and drag over the text) and then open the font menu.

 

To Add and Revise Bullets

 

Go to 

 

Format/Bullet.

                                                                                                                                           

 

Diagrams          

 

                                                                                                                                                            

 

To draw diagrams, make sure the following toolbar is visible on the screen. It should be on the lower left of  the Pow-
erPoint window, just below the View toolbar. If  you don’t see the toolbar, go to 

 

Tools/Customize

 

. Click on the tab 
labeled 

 

Toolbars

 

 and mark the box next to 

 

Drawing

 

. After you close the dialog box, you will see the Drawing menu 
bar. You can move the menu bar by clicking and dragging the bar to a new location.

In order to draw, click the mouse key 

 

once

 

 

 

on the button you want to activate. Release the mouse key and go to the 
slide area. Your mouse pointer should be in the shape of  a cross. At that point, click and drag to draw a line or 
square.

 

To Edit the Object

 

Double-click on the object and a dialog box will appear in which you can edit the color, border line, size, and the 
position of  the object. 
You can also get there with 

 

Format/Colors and Lines

 

. 

 

To Move the Object

 

Click once on the object and holding the mouse key down, move the object to the new location.

Mark this box if you want to
use bullets.

Choose bullet color.

Click on this Arrow to select a
different set of bullets.

Click on the bullet and choose
OK.



  
To Resize the Object

 

Click once on the object to select it. With the mouse key down, drag the sizing handle.

 

To Add Text within Objects

 

Click once on the object, click on the 

 

right

 

 mouse button and select 

 

Add Text

 

. Start typing your text.

 

                                                                                                                                  Graphs                                                                                                                                         

 

Go to 

 

Insert/Chart 

 

to activate the Microsoft Graph feature. You will see this window.

Type your data over the default values in the Data sheet area. To choose a different chart type, go to 

 

Chart/Chart 
Type

 

 and select the appropriate format.

Any necessary revision to the graph can be done by double-clicking on the item that needs to be revised. For exam-
ple, in order to change the bar color, double-click on a bar to activate the 

 

Format Data Series

 

 dialog box. If  you 
need to re-scale your Y axis, double-click on it to activate the 

 

Format Axis

 

 dialog box.

You can also import charts from Excel. Create a chart in Excel, and copy and paste it into your PowerPoint presenta-
tion. If  you double-click on the chart within PowerPoint, the Excel document containing the chart will be activated 
for editing.



 

Steps for Creating Build Animation

1. Make sure your slide appears in the
box and text box is selected.

2. Click on the Effects tab and choose
the animation feature.

3. Choose the text level (all at once, by
word, or by letter) and paragraph
level.

4. If you want the already-introduced
text to dim into a different color, go
to the After Animation section.

5. Preview your selection before
finalizing

 
                                                                                                               Animation                                                                                                                                                      

 

To Insert a Build Effect

 

Build effects

 

 refer to the way you introduce your text during a slide show. For example, if  you have a list and prefer 
to display one sentence at a time instead of  the entire text box, go to 

 

Slide Show/Custom Animation

 

 and select 
appropriate features from the following dialog box. 

Important Tip: Make sure your text box is highlighted before going to the Custom Animation menu.

 

To Insert a Slide Transition

 

Slide Transition

 

 refers to the way each slide is introduced during your presentation. Different types and combina-
tions of  transitions can create nice animation effects

 

. Slide Show/Slide Transition 

 

gets you to the proper dialogue 
box.To Add Other Animation Effects

 

Preset Animation

 

 and 

 

Action Settings.

 

 Preset Animation under the 

 

Slide Show

 

 menu offers various animation 
features which can be applied to the text box. Make sure the text box is defined first in order to activate Preset Ani-
mation effects. The Action Settings option is also found under 

 

Slide Show.

 

 Use this option to embed buttons that 
can be linked to slides within the presentation, WWW sites, application programs, or macros. 



  

To Add Other Animation Effects

 

Preset Animation 

 

and 

 

Action Settings

 

. Preset Animation under the 

 

Slide Show

 

 menu offers various animation 
features which can be applied to the text box. Make sure the text box is defined first in order to activate Preset Ani-
mation effects. The Action Settings option is also found under 

 

Slide Show

 

. Use this option to embed buttons that 
can be linked to slides within the presentation, WWW sites, application programs, or macros. 

 

Animated GIF pictures: 

 

PowerPoint supports the playing of  animated GIF pictures to add motion to your presen-
tations.

 

                                                                      Other  Great  Tricks  to  Spice Up  Your  Presentation                                                                

 

Scanner support

 

: You can scan a picture directly into PowerPoint from most TWAIN-compatible scanner and digi-
tal cameras.

 

Animated GIF pictures: 

 

PowerPoint supports the playing of  animated GIF pictures to add motion to your presen-
tations.

 

Numbered lists: N

 

umbered lists are now supported in PowerPoint. When you change the order of  items in a num-
bered list, PowerPoint automatically renumbers the list for you

 

 

Graphical bullets: N

 

ew graphical bullets add extra flair to your slides. They can be used to replace the standard 
font-based bullets. A large selection of  bullets is included, and you can import your own custom-made bullets as well.

 

Collect and paste with the Office Clipboard: 

 

Use the new Office Clipboard to collect objects from all of  your 
programs, including your Web browser, and paste them when you need them. You can store up to 12 objects on the 
Office Clipboard.

 

Steps for Creating Action
Buttons

 

1. First click on the desired icon.

2. Click on the slide to paste the
button. The 

 

Action Settings

 

dialog box will be activated.

3. Click next to 

 

Hyperlink to:

 

 and
choose the action which should be
linked with the button.

4. Double-clicking on the button will
enable you to edit its color.



  
                                                                                 Saving and Printing Your Presentation                                                                           

 

To Save Your Presentation

 

Go to 

 

File/Save As

 

. PowerPoint files are distinguished by the extension.PPT. 

 

To Print Your Presentation:

 

Go to 

 

File/Print

 

. By clicking on the down arrow key next to the Print What section, you will see various printing 

options including printing slides (one slide per page), handouts (2, 3, 4, 6 or 9 slides per page), notes pages, and out-

line view. You are able to print in a horizontal or vertical format. After selecting the appropriate format, click OK to 

print.

 

 

 

Uploading Your Presentation to the World Wide Web

 

Go to 

 

File/Save as HTML

 

 and follow the Wizard steps. 

 

Round-trip HTML   You can save a presentation as a 

Web page and reopen it in Microsoft PowerPoint, without losing any of  the formatting or contents.

Customizable Web pages:Quickly change how PowerPoint generates and formats Web pages through the Web 

Options dialog box (Tools menu, Options command, General tab, Web Options button). For example, you can 

customize where graphics and other supporting files are stored, and specify what format graphics are saved in for use 

on Web pages. Whenever possible, the options are shared across all Microsoft Office programs. Use design templates 

to create Web pages with a professional look. Without saving your file, you can quickly preview your Web page in 

your browser with the Web Page Preview command (File menu).

Web server access:Use the Web Folders feature to manage your files stored on a Web server. You can access Web 

Folders through Windows Explorer, or through any Office program. Use Web Folders to create folders, view proper-

ties, and drag files to any Web server that you have permissions to.

Presentation broadcasting   With presentation broadcasting you can schedule and give a slide show over the Web, 

complete with audio and video. Broadcast presentations can be saved on a Web site for future playback.

Automatic file and link management   PowerPoint automatically manages companion files, such as graphics. 

When you create a Web page, all supporting files are stored in a file folder with the same name as the main.htm file. 

When you save your presentation to a new location, PowerPoint checks the links and repairs those that aren’t work-

ing.


